MOVES2014a User Guide

Assessment and Standards Division
Office of Transportation and Air Quality
U.S. Environmental Protection Agency
Chapter 1
Explore MOVES
Introduction

MOVES is the U.S. Environmental Protection Agency's (EPA) Motor Vehicle Emission Simulator. It is used to create emission factors or emission inventories for both onroad motor vehicles and nonroad equipment. The purpose of MOVES is to provide an accurate estimate of emissions from cars, trucks and non-highway mobile sources under a wide range of user-defined conditions.

In the modeling process, the user specifies vehicle types, time periods, geographical areas, pollutants, vehicle operating characteristics, and road types to be modeled. The model then performs a series of calculations, which have been carefully developed to accurately reflect vehicle operating processes, such as running, starts, or hoteling, and provide estimates of total emissions or emission rates per vehicle or unit of activity. Specifying the characteristics of the particular scenario to be modeled is done by creating a Run Specification, or RunSpec.

In addition, the MOVES model includes a default database that summarizes emission relevant information for the entire United States. The MOVES team continually works to improve this database, but, for many uses, up-to-date local inputs will be more appropriate, especially for analyses supporting State Implementation Plans (SIPs) and conformity determinations.

This user guide to the EPA’s MOVES2014a model provides an introduction to how to use the model to estimate air pollution emissions from cars, trucks and non-highway mobile sources. An appendix is provided for experienced MOVES2010 modelers that summarizes how to use features that are new in MOVES2014a. A second appendix provides a “decoder” for some of the most important identifiers used in MOVES inputs and outputs.

This guide is one of one of many documents available to help users of the model. The MOVES2014a User Interface Manual provides insight and best practices to various components of MOVES. The MOVES2014a Module Reference provides step-by-step module algorithms and module and database cross references. MOVES2014a Software Design and Reference Manual assists users with configuring and installing MOVES as well as discussing how MOVES works behind the GUI. These documents and training materials, and technical and policy guidance are available on the MOVES website, http://www.epa.gov/otaq/models/moves/index.htm.

The first section of the MOVES user guide describes the MOVES Graphical User Interface (GUI) including menu items and the navigation panel. It uses an example of an Onroad National Scale run to demonstrate the MOVES GUI. This is an excellent place to start if you’re new to MOVES and unfamiliar with the GUI.
MOVES Graphical User Interface (GUI)
To run MOVES, you must create a “Run Specification” (or RunSpec). This is an XML file that describes your choices for the model run. The MOVES GUI contains a **Menu** and a **Navigation Panel** both designed to help you complete the RunSpec.
MOVES Menu Items
Clicking on a Menu item reveals a drop-down menu from which you will select an action.

File Menu
1. Click **File**.
2. Once the drop-down menu is open, select any of the standard items.
   - **New** will open a new RunSpec;
   - **Open** will open an existing RunSpec;
   - **Close** will close the current RunSpec;
   - **Save** will save the current RunSpec without changing the filename;
   - **Save As** will allow you to create a new RunSpec name and save;
   - **Print** will print the XML version of the RunSpec.

**Note:** When naming your RunSpec, we recommend including appropriate descriptive information such as the type of run, geographic area, year or other information to distinguish from similar RunSpecs. Only letters, numbers, and underscores (_) should be used. We suggest using a .mrs ("MOVES RunSpec") extension, e.g. NewYorkState_2009_GHG.mrs.
3. If you’ve used MOVES before, you can also open a recent RunSpec (the most recent three are displayed).

**Note:** Saved RunSpecs can be reloaded and run again or edited.
4. Click **Exit** to close MOVES.
Edit Menu

1. Click **Edit**.
2. Once the drop-down menu is open, select any of the standard items. 
   - **Cut** will remove selected text and copy it to the clipboard;  
   - **Copy** will copy the selected text to the clipboard;  
   - **Paste** will input text cut/copied from the clipboard;  
   - **Clear** will remove the selected text.

**Note:** These functions are only available in text entry sections of MOVES.
Pre Processing Menu
The Pre-Processing menu is used to select options for entering data in MOVES. These menu options are specific to the analysis scale selected in the Scale panel. Selecting one of these options opens a new screen that allows data to be entered in MOVES.

1. Click **Pre Processing**.
2. Click **Data Importer** to enter data at the National Scale (optional); click **County Data Manager** to enter data at the County Scale (required); click **Project Data Manager** to enter data at the Project Scale (required). These three importers are relevant only for highway vehicle runs. There is a **Nonroad Data Importer** relevant to import data on off-road mobile equipment for MOVES-Nonroad runs.

**Note:** Local county or project level data are entered into MOVES after the completion of the RunSpec and before MOVES is run. Each data manager contains a template to ensure data is entered in the correct format.

**Action Menu**

1. Click **Action**.
2. Click **Execute** to run MOVES once your RunSpec is created; **Stop** to stop a MOVES run in progress (can’t be resumed); **Pause** to pause a MOVES run in progress; **Resume** to resume a paused MOVES run; **MOVES Run Error Log** to display the error log for a selected output database.
Post Processing Menu

1. Click **Post Processing**.
2. Click **Run MySQL Script on Output Database** to further process a MOVES output database using a set of MySQL scripts; click **Run MySQL Script on Nonroad Output Database** to further process a MOVES Nonroad output database using a set of MySQL scripts; **Produce Summary Report** to customize information contained in a MOVES output database; **Produce State/County Map** to display a MOVES output database in color or gray-scaled maps.

![MOVES Post Processing Options](image)

**Note:** These options are available only after a MOVES run has completed successfully.
Tools Menu

1. Click **Tools**.
2. Click **Multiple RunSpec Creator** to create a batch of similar MOVES runs;  
**Process DONE Files** if you’re an advanced user using MOVES in a network (not recommended for most users);  
**Database Converter** to convert a MOVES2010b input database into a MOVES2014 database (County and Project scales).
Settings Menu

1. Click **Settings**.
2. Click **Configure MOVES** to set-up the basic MOVES operating configuration. Most users should not need this function.
Help Menu

1. Click Help.
2. Click **MOVES User’s Guide** to open a website where you can download this guide or other MOVES documentation. Click **About MOVES** to view the version and release date of the MOVES software you’re using.
Navigation Panel
The Navigation Panel lists different portions of the RunSpec. Clicking an item in the Navigation Panel displays a sub-panel that assists you in making selections for that section. A RunSpec includes your choices for location, time period, alternate input data, and output preferences. In order for MOVES to process your RunSpec, each item in the Navigation Panel must show a green checkmark, which indicates that all necessary selections for that sub-panel have been made, or yellow tildas symbol, which indicates that making selections in the sub-panel is optional (shown below).
Description Panel
The Description Panel allows you to enter a text description of the RunSpec. Include the location, time period being modeled, type of pollutant modeled, and anything unique about the RunSpec. This description will appear in the MOVESRun table of the output database. This is optional, but recommended to help keep track of the purpose of each MOVES run.

1. Click **Description**. Enter your desired text (up to 5,000 characters of text, but no quote, ampersand or backslash characters allowed).
Scale Panel
The Scale Panel is where you select the model type (Onroad or Nonroad), analysis scale (National, County, or Project) and the calculation type (Inventory or Emission Rates).

1. Click Scale. Select the appropriate button for each choice. Note, these selections change what options are available on other sub-panels. Changes here can erase selections on other panels.
**Time Spans Panel**

The Time Spans Panel is where you define the time period for which MOVES will calculate emissions. There are five sections in this panel and all sections must be populated.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Time Aggregation Level</strong></td>
<td>Only one selection can be made. The default is Hour and this is what must be used for any regulatory purpose.</td>
</tr>
<tr>
<td><strong>Years</strong></td>
<td>Enter only one year at a time for County and Project Scales; multiple years can be selected for National Scale. For Nonroad runs, we suggest running only one year at a time to keep output size manageable.</td>
</tr>
<tr>
<td><strong>Months</strong></td>
<td>One or more months (including all) can be selected.</td>
</tr>
<tr>
<td><strong>Days</strong></td>
<td>One or both types can be selected.</td>
</tr>
<tr>
<td><strong>Hours</strong></td>
<td>One or more hours (including all) can be selected. All hours must be selected for any run that estimates hydrocarbon emissions.</td>
</tr>
</tbody>
</table>

1. Click **Time Spans**.
Geographic Bounds Panel
The Geographic Bounds Panel is where you define the geographic area in which MOVES calculates emissions. The options available are based upon your Scale Panel choice.

<table>
<thead>
<tr>
<th>Scale Panel Selection</th>
<th>Options for Geographic Bounds Panel</th>
</tr>
</thead>
</table>
| National              | • Nation (except Puerto Rico and the Virgin Islands)  
                        | • State (select one or more)  
                        | • County (select one or more, can be in different states) |
| County                | • County  
                        | • Custom Domain |
| Project               | • County  
                        | • Custom Domain |

1. Click **Geographic Bounds**.
Vehicles/Equipment
The Vehicles/Equipment panels are where you define the types of vehicles you're including in your RunSpec. For most analyses, all valid gasoline, diesel, ethanol and CNG vehicle combinations are used.

Not all vehicle/fuel type combinations are valid. Selecting invalid fuel and source type combinations (e.g., diesel motorcycles) will cause informational notes to be displayed in the bottom window of this panel, but does not cause problems with the MOVES run or with model results. Include all valid vehicle/fuel combinations to accurately account for total emissions for each source type. If all the valid combinations are not selected in the RunSpec, emissions from those missing combinations will be lost in the model output and the results will not be accurate.

The table below lists the vehicle types available for onroad analysis and their associated FHWA VM-1 vehicle types. If you select Nonroad on the scale panel, a list of nonroad
equipment is provided. Only valid combinations of fuel type and nonroad sector are shown in the GUI.

**MOVES Source Use Types and HPMS Vehicle Types**

<table>
<thead>
<tr>
<th>MOVES Source Type ID</th>
<th>Source Types</th>
<th>HPMS VM-1 Vehicle Type ID</th>
<th>Vehicle Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Motorcycle</td>
<td>10</td>
<td>Motorcycles</td>
</tr>
<tr>
<td>21</td>
<td>Passenger Car</td>
<td>25</td>
<td>Light Duty Vehicles</td>
</tr>
<tr>
<td>31</td>
<td>Passenger Truck</td>
<td>25</td>
<td>Light Duty Vehicles</td>
</tr>
<tr>
<td>32</td>
<td>Light Commercial Truck</td>
<td>25</td>
<td>Light Duty Vehicles</td>
</tr>
<tr>
<td>41</td>
<td>Intercity Bus</td>
<td>40</td>
<td>Buses</td>
</tr>
<tr>
<td>42</td>
<td>Transit Bus</td>
<td>40</td>
<td>Buses</td>
</tr>
<tr>
<td>43</td>
<td>School Bus</td>
<td>40</td>
<td>Buses</td>
</tr>
<tr>
<td>51</td>
<td>Refuse Truck</td>
<td>50</td>
<td>Single Unit Trucks</td>
</tr>
<tr>
<td>52</td>
<td>Single Unit Short-Haul Truck</td>
<td>50</td>
<td>Single Unit Trucks</td>
</tr>
<tr>
<td>53</td>
<td>Single Unit Long-Haul Truck</td>
<td>50</td>
<td>Single Unit Trucks</td>
</tr>
<tr>
<td>54</td>
<td>Motor Home</td>
<td>50</td>
<td>Single Unit Trucks</td>
</tr>
<tr>
<td>61</td>
<td>Combination Short-Haul Truck</td>
<td>60</td>
<td>Combination Trucks</td>
</tr>
<tr>
<td>62</td>
<td>Combination Long-Haul Truck</td>
<td>60</td>
<td>Combination Trucks</td>
</tr>
</tbody>
</table>
1. Click **Vehicles/Equipment**.
2. Click **On Road Vehicle Equipment**. Make appropriate selections of Fuels and Source Use Types (or nonroad equipment) and then Add Fuel/Type Combinations to create the list of vehicles/equipment for your RunSpec.
Road Type Panel
The Road Type Panel is where you indicate which road type you’re including in your RunSpec. You generally select all road types unless there is a specific reason not to, such as when you’re estimating emissions from a specific facility using the Project Scale.

Available Road Types

<table>
<thead>
<tr>
<th>Road Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off-Network</td>
<td>Captures emissions that occur while vehicles are not moving, i.e., start, extended idle (hoteling of long haul combination trucks), and resting evaporative emissions. Idle emissions that occur during normal running operation, such as at signalized intersections, is captured in the other road types.</td>
</tr>
<tr>
<td>Rural Restricted</td>
<td>Captures running emissions, including running evaporative emissions. Restricted indicates restricted vehicle access via ramps, such as freeways and interstates.</td>
</tr>
<tr>
<td>Rural Un-Restricted</td>
<td>Captures running emissions, including running evaporative. Un-Restricted indicates all other rural roads not included in Restricted.</td>
</tr>
<tr>
<td>Urban Restricted</td>
<td>Captures running emissions, including running evaporative. Restricted indicates restricted vehicle access via ramps, such as freeways and interstates.</td>
</tr>
<tr>
<td>Urban Un-Restricted</td>
<td>Captures running emissions, including running evaporative. Un-Restricted indicates all other urban roads not included in Restricted.</td>
</tr>
</tbody>
</table>
1. Click **Road Type**.

**Note:** Emissions and activity on or due to restricted access roads can be further split to show ramp and non-ramp data. Clicking the **Provide separate ramp output** checkbox will provide additional road types in the output database to hold these split values.
Pollutants and Processes Panel
The Pollutants and Processes Panel is where you choose pollutants and processes for your RunSpec. Some pollutant/process selections automatically select certain road types. Some of the listed pollutants are aggregates of other pollutants.

Some pollutants/processes are chained (i.e. some pollutants are calculated as ratios to others). MOVES will indicate in the bottom sub-panel which additional pollutants or processes must be selected if they are not already chosen. Click the Select Prerequisites button to automatically choose all required pollutants.

1. Click Pollutants and Processes. Click in the boxes to the right to select specific combinations of pollutant and process. Note, this panel continues beyond what is displayed on most screens. Click the box on the left to select all processes for a given pollutant. Clicking the “+” by some aggregate pollutants will show a detailed list of species that make up the aggregate category.
Manage Input Data Sets Panel
The Manage Input Data Sets Panel is not used in most cases. Its function has been replaced by the Data Importer, County Data Manager (CDM), and Project Data Manager (PDM). It provides an alternative to way to input data, but does not include the data checks built into the other importing methods. However, you must click this panel in order to get a green check that allows you to execute your RunSpec.

1. Click **Manage Input Data Sets**.
Strategies
The Strategies section contains the Rate of Progress Panel. The Rate of Progress Panel allows you to estimate emissions as if the 1990 Clean Air Act Amendments had not been implemented.

1. Click **Strategies**.
2. Click **Rate of Progress**. If you need to model a “no Clean Air Act Amendments” scenario as part of an ozone reasonable further progress SIP, you would check the box for Compute Rate-of-Progress “No Clean Air Act Amendments” Emissions. Use of this feature is limited to a very narrow set of circumstances and you should check appropriate EPA guidance documents and/or contact your EPA Regional Office before using this feature.
Output Panels
The Output Panels are the General Output Panel and the Output Emissions Detail Panel.

General Output Panel
The output database is where the RunSpec results are stored and the units reported. You indicate an output database by entering a unique name and by telling MOVES to create the output database file, or referencing an existing database. Output from multiple RunSpecs can be stored in the same database and are each identified by a different MOVES run ID. Combining output from multiple runs is recommended only when there is a reason to do so (e.g. when each run is a county in a non-attainment area and the results will be summed later).

Units must be selected for Mass, Energy, and Distance. Activity selections are optional and activity is reported only for the selections made (e.g. geographic area, time period, vehicles). See the Reference Manual for more detail on activity types.
1. Click **Output**.
2. Click **General Output**.
**Output Emissions Detail Panel**

The Output Emissions Detail Panel defines the level of detail you want MOVES to report. You define the time period for which you want results reported, the geographic area for which you want results reported, and whether you want emissions broken out by fuel type, emissions process, or vehicle type.

The default level of output for time is the same selection made in the Time Spans Panel. You can select a longer period of time (e.g. if you had selected Hour in the Time Spans Panel, you can select Month here), but not a shorter period of time. If you do select a longer period of time, be aware that MOVES will only sum the data available. (For example, if you select only 9am-10am in the Time Span Panel and request output by month, the results will be the sum of emissions in that hour for the month.)

The default level of output for location is the same geographic level selected in the Geographic Bounds Panel. You can select a larger geographic area, but not a smaller one. Again, the model will only sum the detail selected in the Geographic Bounds panels.

Other output detail is optional. Model Year will provide a line of output for each model year which will increase the number of output lines by 31 times. Emissions Process includes separate output for each process selected in the Pollutants and Processes panel. Source Use Type is type of vehicle and is generally a useful output. SCC is an EPA reporting code. Reg Class refers to EPA regulatory classes.

1. **Click Output Emissions Detail.** Select desired options.
Advanced Performance Features Panel
The Advanced Performance Features Panel is not generally used. The Masterloopable Components sub-panel is intended to speed up batch runs by allowing users to save intermediate output from one run and to reuse it for another run with identical activity or other characteristics. Other options on this panel are for diagnostic work only.

1. Click **Advanced Performance Features**. Select intermediate data to save or reuse. Indicate the destination database where this data is to be stored.
Running MOVES
When your RunSpec is complete, you can run the MOVES model by saving and executing the RunSpec using the menu at the top of the interface panel.
Chapter 2
Using the MOVES County Scale
Introduction
This section covers how to develop a County Scale RunSpec for on-road sources using the County Data Manager. County Scale is required for State Implementation Plan (SIP) and Conformity analyses. County specific data must be entered when the County Scale is selected. You can import or export data with the County Data Manager. It’s important to note that local data should be used for most inputs and that default data are not available for all inputs.

This example scenario is intentionally simplified to facilitate learning to use MOVES for an On-road scenario at the County Scale. A RunSpec constructed to calculate an inventory for a SIP or conformity analysis would have to completely address all variables as described in EPA guidance.

Set-up the entire RunSpec first before the county inputs are added. This enables the County Data Manager (CDM) to filter the default database for relevant information.

Further guidance can be found online: http://www.epa.gov/otaq/models/moves/index.htm

Developing a County Scale MOVES RunSpec
1. Ensure MOVES is open. Click File > New.
2. Click **Description** and enter your RunSpec information (up to 5,000 characters of text, but no quote, ampersand or backslash characters allowed).
3. Click **Scale**; select the **County** radio button under **Domain/Scale**.

**Notes:** County scale must be used for SIPs or transportation conformity analyses. **Model** default is **Onroad** and would not be changed for this inventory.
4. Choose the **Inventory** radio button under **Calculation Type**.

![Image of MOVES interface showing Inventory option highlighted]

**Note:** Either **Inventory** or **Emission Rates** options may be used for SIPs or transportation conformity analyses. Chapter 5 provides more information on Emission Rates.
5. Click **Time Spans**; select the **Hour** radio button under **Time Aggregation Level**.

**Note**: For all regulatory purposes, **Time Aggregation Level** should be set to hour.
6. Under **Years**, select a year from the **Select Year** drop-down menu; click **Add**.

**Note:** You can only select one year for a County scale RunSpec.
7. Under **Months**, select a month (or months) by clicking the box (or boxes). A checkmark will appear in the box next to the selected month(s).

**Note:** You may also click **Select All** to select all months of the year. If you make an error in your choices, you may also click **Clear All** to remove all checkboxes in this section and start over.
8. Under the **Days** section, choose your option(s) by clicking the box (or boxes) next to **Weekend** and/or **Weekdays**. A checkmark will appear in the box next to the selected options(s).

![Image of MOVE software interface with Days section highlighted]

**Note:** You may also click **Select All** to select both options. If you make an error in your choices, you may also click **Clear All** to remove all checkboxes in this section and start over.
9. Under **Hours**, choose the preferred time frames from the **Start Hour** and **End Hour** drop-down menus.

**Note:** You may also click **Select All** to select a 24-hour time period (as shown above). For Regulatory purposes, all hours must be modeled. If you make an error in your choices, you may also click **Clear All** to reset the drop-downs in this section and start over.
10. Click **Geographic Bounds**; select the **County** radio button.
11. Select a state from the **States** drop-down menu.

**Note:** The selections chosen are for training purposes only.
12. Select a county from the **Counties** drop-down menu; click **Add**.

**Note:** The Domain Input Database section allows the user to create or select a county database, and allows access to the available limited default data stored for that county. This section of the Geographic Bounds panel should be left blank until the rest of the RunSpec is completed. Move on to the next section even though a red exclamation mark remains for Geographic Bounds.
13. Click **Vehicles/Equipment**; click **On Road Fuel Equipment**.
14. Select a fuel (or fuels) from the **Fuels** list.

**Note:** Selections chosen are for training purposes. For most analyses, select all gasoline, diesel, ethanol, and CNG vehicle combinations. You can select multiple fuels by holding the `<crtl>` button while clicking your selections.
15. Select a source use type (or types) from the **Source Use Types** list; click **Add Fuel/Type Combinations**.

**Note**: You can select multiple source use types by holding the `<crtl>` button while clicking your selections. Your selections will appear in the **Selections** list after you click **Add Fuel/Type Combinations**.

**Note**: For a complete emissions inventory of all sources, select all fuel and source use type combinations. Not selecting all fuels for a particular source type may lead to results that are inconsistent with the VMT entered in MOVES for that source type. The model will no longer allow the user to select invalid fuel and source type combinations (e.g., diesel motorcycles).
16. Click **Road Type**; select a road type (or types) from the **Available Road Types** list; click **Add**.

**Note:** You can also click **Select All** to add all available road types. Selections shown are for training purposes.
17. Click **Pollutants and Processes**; click the box next to each pollutant you’d like included in your RunSpec. A checkmark will appear next to each selected item. Uncheck to remove.

**Note**: Item chosen is for training purposes. Slide the scroll bar to view all processes selected for each pollutant.

**Note**: Individual boxes under each process can be used to select only certain processes. For a complete inventory of a particular pollutant, you must select all processes.
18. Click **Manage Input Data Sets**.

**Note:** No entries were chosen for this example. You need to click on this panel to get a green check, but no other input is needed. You would use this panel if you had specialized input data created outside of MOVES. In almost all on-road cases, the County Data Manager will be used instead of this panel.
19. Click **Strategies**; click **Rate Of Progress**. You would click the box next to **Compute Rate-of-Progress only** if you need an inventory for emissions based on the assumption that the 1990 Clean Air Act Amendments had not been implemented.

**Note:** The default setting for this panel is a green check and it does not need be selected in order to complete a RunSpec.
20. Click **Output**; click **General Output**; type your output database name in the **Database** field.

![Image of MOVES user interface with Output and General Output options highlighted]

**Note:** We recommend you name your output database ending with “_out”.

**Note:** You can also use the drop-down field to locate an existing database if you’ve previously created one. While it is generally not recommended, results from multiple RunSpecs can be stored in the same output database. Each RunSpec in the output will be identified by different MOVESrunID’s.
21. Click the drop-downs under **Units** to identify **Mass Units**, **Energy Units**, and **Distance Units**.

![Units Drop-downs](image)

**Note:** All units must be selected and populated with values.
22. **Optional step**: Click the box (or boxes) next to the activity (or activities) under the **Activity** section you’d like in your output.

**Note**: Selections shown are for training purposes, but are recommended for your RunSpec.

**Note**: Including activity in the output database provides an opportunity to check whether activity entered in MOVES matches activity output. At a minimum, EPA recommends including Distance Traveled and Population in all runs.
23. Click **Create Database.**
24. You will receive a pop-up message letting you know your output database was successfully created. Click **OK**.
25. Click **Output Emissions Detail**.

**Note:** This panel is used to determine the amount of detail or aggregation of emissions output. Asking for more detail creates larger, more complex output files. Limiting detail provides more aggregated results in smaller output files. Your choice is determined by what you will need to do with the results. If you later determine you needed more detail, you will have to re-do the run.
26. Under Always, choose the desired **Time** and **Location** detail by using the drop-down menus.

**Note:** **Hour** is necessary if the results will need to be allocated by time of day. **County** should be selected for a County Scale run not using a Custom Domain.
27. Under **for All Vehicle/Equipment Categories**, click the box (or boxes) next to categories you want to see in the output.

**Note**: **Model Year** results in output broken down by each of 31 model years for each source type. The other categories should be selected if detailed emissions for each **Fuel Type** and **Emissions Process** are needed.

**Note**: a **Fuel Subtype** box now appears in the GUI (not shown in the figure above) and is in-active for an on-road run. It is active only when a Nonroad simulation is chosen.
28. Under **On and Off Road**, click the boxes next to the selections you’d like in your output.
29. **Optional step.** Click **Advanced Performance Features Panel**. This section is for advanced users and troubleshooting only. Most users will not populate this screen.
30. Save your RunSpec. Click **File > Save**.
31. Navigate to where you store your RunSpecs using the drop-down if necessary.

**Note:** EPA recommends you create a folder specifically for MOVES RunSpecs such as the “MOVES2014 RunSpecs” folder shown here.
32. In the **File Name** field, type the name of your RunSpec; click **Save**.

**Note:** For improved file management, choose a file name that is consistent with the names given to the input and output databases created using the RunSpec, and type “.mrs” (**MOVES RunSpec**) as the file name extension.
Using the County Data Manager to Enter Local Data

The County Data Manager (CDM) is a tool that facilitates the process of entering data into a county input database. The data in the input database is used by MOVES when executing the RunSpec. When the CDM is open, the MOVES GUI is frozen and no changes can be made to the RunSpec.

You will manipulate your data in Excel and then import those worksheets into the CDM. You do not enter data directly into the CDM. However, the CDM can create templates, export default data, or export previously imported data. The files you create through the CDM provide the proper format of the input tables, which is very important.

You will also use the CDM to review your data for accuracy prior to executing the RunSpec. This ensures the most up-to-date information is used in modeling. The CDM imports this data into the county input database. You can add descriptions of the imported data which are useful for documenting data sources. You can also clear previously imported data before importing new data to ensure accuracy and prevent execution errors.

There are two ways to open the CDM.

1. Click **Pre Processing > County Data Manager**.

2. Click **Geographic Bounds** then click **Enter/Edit Data**.
Generate Inventories at the County Scale Level

US Environmental Protection Agency - MOVES User Guide 2014a
A newly opened CDM has many tabs as shown at the top of the image below.

Note: ✔️ appears when data is sufficient and passes error checks for all parameters in the RunSpec. 🚫 appears when insufficient data is provided and/or there are errors.
Using the County Data Manager: Database Tab

The Database tab is where you create or select the county input database. Once you’ve selected or created a county input database, the tables within it can be edited with the other CDM tabs.

1. To create a database, type a database name in the Database field (or select an existing one from the drop-down menu).

*Note:* End all database file names with ‘_in’ to help identify them as input databases.

*Note:* Use a consistent naming convention with similar names for the input database, to the RunSpec file and the output database. Previously created input databases will appear in the drop down menu and can be opened for editing.
2. Click **Create Database**.

![Database Creation Screen](image)

**Note:** All tables in the selected database can be cleared of data by clicking the **Clear All Imported Data** button.
3. Click **OK**.
Using the County Data Manager: Creating a Template

You can create an Excel template spreadsheet from most tabs in the CDM. The template will be pre-populated with some data based upon entries made in the RunSpec. The fields/column headings will be created, but the cells will be blank for your own data.

1. Within most tabs, click the Create Template button.
2. Type a name for the template in the **File name** field.

**Note:** Use the “.xls” or “.xlsx” file extension at the end of your file name. You must provide the file extension.
3. Click **Save**.

*Note:* Ensure you’ve navigated to the folder where you want to store the template.

*Note:* After creating and saving the blank template, you would then open it in Excel, enter the appropriate local data, and save again prior to importing the completed data into MOVES. The process of finding the completed input spreadsheet and importing it into MOVES is described below.
Using the County Data Manager: Exporting Default Data
Not all tabs in the CDM have the Export Default Data option. When the option is available, an Export Default Data will be present on the GUI. To export data when available, follow the steps below. Exporting default data allows you to review the MOVES default data and make any necessary changes before running MOVES.

1. Click the **Export Default Data** button.

![Image showing the MOVES County Data Manager interface with the Export Default Data button highlighted.](image-url)
2. Type a name for the data file in the **File name** field.

**Note:** Use the “.xls” or “.xlsx’ file extension at the end of your file name. You must provide a file extension. We recommend that you use descriptive file names that will make it easier to keep track of what files provide local data for your MOVES run.
3. Click **Save**.

![Image of MOVES County Data Manager interface]

**Note:** Ensure you’ve navigated to the folder where you want to store the data file.

**Note:** After exporting and saving default data, you would then open it in Excel, review and make any changes needed to properly reflect local data, and save again prior to importing the modified data into MOVES. The process of finding the modified data and importing it into MOVES is described below.
Viewing Defaults and Entering Data
Once you have saved MOVES defaults or a blank template, you may view and edit these values with Excel. Using the template will assure that you have correct worksheet and column names.

For guidance on data sources and other requirements, see the most recent MOVES technical guidance on using MOVES to prepare emission inventories in State Implementation Plans and Transportation Conformity available on the web at http://www.epa.gov/otaq/models/moves/index.htm

Using the County Data Manager: Importing Data
All data, including default data, must be imported back into the CDM from Excel for each required tab. Imported data are read from an Excel worksheet that has been properly formatted with the correct columns.

Required tabs are indicated by an ✗ which means more information is required. Tabs with an ✓ are optional for user supplied data. The exception to this is the Ramp Fraction Tab. This tab requires you to complete steps 2-6 below, even though it has an ✓.

You will complete steps 2-6 for each required tab (outlined in the following table).

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Tab Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Type Population</td>
<td>Source Type Population is the actual number of vehicles of each source type in the country being modeled. This tab inputs the number of local vehicles operating in the area. It’s important for start and evaporative emissions. MOVES table is SourceTypeYear.</td>
</tr>
<tr>
<td>Vehicle Type VMT</td>
<td>This tab inputs the total annual or daily VMT by HPMS vehicle type or source type. It also includes month, day, and hour VMT fractions. Month VMT fractions are the fraction of annual VMT (per source type) occurring per month. Day VMT fractions are the fraction of monthly VMT (per source type) occurring on one of the two day types (weekday or weekend). Hour VMT fractions are the fraction of daily VMT (per source type) occurring per hour. The default MOVES table for VMT is HPMSVTypeYear; however, this table may be substituted using the HPMSVtypeDay, SourceTypeYearVMT, or SourceTypeDayVMT table.</td>
</tr>
<tr>
<td>I/M Programs</td>
<td>This tab inputs data on I/M programs if any exist. MOVES table is IMCoverage.</td>
</tr>
<tr>
<td>Fuel</td>
<td>This tab inputs market share and composition of fuel blends and fractions of vehicles using each fuel type. Defaults are available by county. MOVES tables are FuelSupply, FuelFormulation, FuelUsageFraction, and AVFT.</td>
</tr>
<tr>
<td>Meteorology Data</td>
<td>This tab inputs temperature and humidity inputs. Meteorology data should be entered for every month and hour selected in the RunSpec. MOVES table is ZoneMonthHour.</td>
</tr>
<tr>
<td>Ramp Fraction</td>
<td>This tab inputs information about the fraction of freeway VHT occurring on ramps. MOVES table is RoadType.</td>
</tr>
<tr>
<td><strong>Road Type Distribution</strong></td>
<td>This tab inputs information on the fraction of source type VMT on different road types. MOVES table is RoadTypeDistribution.</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Age Distribution</strong></td>
<td>This tab inputs age fractions of fleet by age and source type. Age Distribution is entered according to MOVES source types and calendar year and covers new to 30+ year old vehicles. MOVES does not vary age distribution by month. MOVES table is SourceTypeAgeDistribution.</td>
</tr>
<tr>
<td><strong>Average Speed Distribution</strong></td>
<td>This tab inputs data on speed distribution by road type, hour, and source (vehicle) type. MOVES has 16 speed bins ranging from 2.5 to 75+ mph. Average Speed Distribution is in terms of time, not distance (i.e. fraction of VHT, not VMT, for each speed bin). MOVES table is AvgSpeedDistribution.</td>
</tr>
<tr>
<td><strong>Hotelling</strong></td>
<td>Hotelling hours is nominally the total number of hours spent by truck drivers in their trucks during mandated rest periods between trips during long haul operations. This tab inputs total hotelling hours and the operating distribution for vehicles during hotelling hours. Time can be divided between extended idling and auxiliary power unit (APU) operation and other operating modes. The MOVES tables are hotellingActivityDistribution and hotellingHours.</td>
</tr>
</tbody>
</table>

1. Click the **Source Type Population** tab.
2. Click **Browse**.
3. Click the Excel file you want to import; click **Open**.
4. Click the worksheet to use (should match Data Source in the CDM tab); click **OK**.
5. Add a description for the imported data in the **Description of Imported Data** field; click **Import**.

**Note:** Be sure to add a description for the imported data. This will appear in the log and can help you differentiate between multiple imported files.
6. Verify the file was imported by clicking the **Database** tab to view the log.

You must do this for each required tab. Click each required tab, then complete steps 2-6 outlined above. There is one extra step prior to step 2 to complete the Vehicle Type VMT tab, discussed in greater detail below.

**Vehicle Type VMT Tab**

This tab contains VMT importers allowing the user to specify whether the input VMT is by HPMS class or by source type, and whether the VMT values are annual or daily. First, click on the radio buttons to select that the VMT is by either HPMS class or Source Type. Next, you must click a second radio button to specify if the VMT data represents Annual or Daily VMT. The default selections are HPMS and Annual. Your radio button selections affect the GUI display and required input files for your run.

Begin by clicking the **Vehicle Type VMT** tab and making your radio button selections.
As an example, select **Source Type** under **Input VMT by** and **Daily** under **VMT values are**.
Now repeat steps 2-6 (browsing and importing input tables) outlined above to complete the Vehicle Type VMT tab. For day, hour, and month VMT fraction, you may consider exporting and importing MOVES default data. You must complete steps 2-6 outlined above for each required tab.

Generic Tab
This tab contains a drop-down list of MOVES table names. From here, you can import data not provided for on the other tabs. There is no data validation provided for generic imports on this tab. Changing data in other MOVES tables can cause MOVES to not function properly and may not be appropriate for regulatory purposes. You should review EPA Guidance for examples of appropriate changes before using this tab.
Executing the RunSpec

You should now see green checkmarks next to each option on the left side of the Navigation Panel. If Geographic bounds still has a red check, click on another option (e.g., Time Spans) and click on Geographic Bounds again to refresh it.

1. Click **Geographic Bounds**.
2. Verify the correct input database is selected.
3. Click **Action > Execute**.
4. Click **Yes** to save the RunSpec before executing.
5. MOVES is now executing your RunSpec. Two windows will pop-up during execution, but require no action on your part.
6. Click **OK** when the **Run Completion** window appears.
Chapter 3
Process MOVES Output
Introduction

In this section, we explain what is contained in MOVES output tables and explore the Post-Processing Menu and MySQL Scripts. All of the results of a MOVES RunSpec are stored in MySQL database tables. These results can be accessed via MySQL Workbench using query commands or a number of other tools (e.g. Microsoft Access, Python, R, SAS, etc.) with MySQL Open Database Connectivity (ODBC). The results can also be exported from Workbench to Microsoft Excel. Please note that the MySQL Query Browser tool commonly used with MOVES2010 is no longer supported by Oracle and has been replaced by MySQL Workbench. More information on using MySQL Workbench can be found online at https://dev.mysql.com/doc/workbench/en/wb-sql-editor.html. Information about proper MySQL query syntax and on using other tools for analyzing data in MySQL databases is readily available on the web.

Frequently asked questions and more can be found online at http://www.epa.gov/otaq/models/moves/.

Exploring MOVES Output Tables

The MOVES output database contains numerous output tables with results of the RunSpec, input data, and other information about the RunSpec. The three main tables are:

<table>
<thead>
<tr>
<th>Table Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MOVESOutput table</td>
<td>Contains the quantity of emissions by sourcetype, pollutant/process, etc. It is based upon output detail selections made in the RunSpec.</td>
</tr>
<tr>
<td>MOVESActivityOutput table</td>
<td>Contains the quantities (miles, number of vehicles, starts, or hours) of activity types selected in the General Output panel during RunSpec creation. These can be useful to check that all activity entered in MOVES was accounted for during the run.</td>
</tr>
<tr>
<td>MOVESRun table</td>
<td>Information about the RunSpec such as the date/time of the RunSpec, domain and scale, and units selected.</td>
</tr>
</tbody>
</table>

Additional output tables are only populated when doing an Emission Rates run (not relevant to Inventory run):

1. RatePerDistance
2. RatePerVehicle
3. RatePerProfile
4. RatePerHour
5. RatePerStart

Other output tables are useful for reference and diagnostic purposes:

1. ActivityType
2. MOVESError
Using the Post-Processing Menu: Run MySQL Script on Output Database

MOVES post-processing scripts are applied to the current output database as selected in the active RunSpec. Thus, it is easiest to perform Post-Processing immediately after executing your RunSpec. Click **Post Processing > Run MySQL Script on Output Database.**

**Note:** Scripts may require you run MOVES in a particular way. Ensure you’ve read the script documentation prior to running MOVES.
1. Select the desired script from the **Select output processing script** drop-down.
### Post-Processing Scripts List

<table>
<thead>
<tr>
<th>Script Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DecodeMOVESOutput.sql</td>
<td>Decodes most key fields of the MOVESOutput and MOVESActivityOutput tables.</td>
</tr>
<tr>
<td>EmissionRates.sql</td>
<td>Produces an output table which reports the emission results in units of mass per distance.</td>
</tr>
<tr>
<td>TabbedOutput.sql</td>
<td>Produces tab-delimited output suitable for reading into an EXCEL Spreadsheet from the MOVES MySQL database output tables.</td>
</tr>
</tbody>
</table>

### Post-Processing Scripts List: Project Scale Runs

<table>
<thead>
<tr>
<th>Script Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CO_CAL3QHC_EF.sql</td>
<td>Produces CO emission rates for use in the CAL3QHC air quality model.</td>
</tr>
<tr>
<td>CO_Grams_Per_Hour.sql</td>
<td>Produces CO emission rates as grams per hour for each link.</td>
</tr>
<tr>
<td>CO_Grams_Per_Veh_Mile.sql</td>
<td>Produces CO emission rates as grams per vehicle-mile for each link.</td>
</tr>
<tr>
<td>PM10_Grams_Per_Hour.sql</td>
<td>Produces PM10 emission rates as grams per hour for each link.</td>
</tr>
<tr>
<td>PM10_Grams_Per_Veh_Mile.sql</td>
<td>Produces PM10 emission rates as grams per vehicle-mile for each link.</td>
</tr>
<tr>
<td>PM25_Grams_Per_Hour.sql</td>
<td>Produces PM2.5 emission rates as grams per hour for each link.</td>
</tr>
<tr>
<td>PM25_Grams_Per_Veh_Mile.sql</td>
<td>Produces PM2.5 emission rates as grams per vehicle-mile for each link.</td>
</tr>
</tbody>
</table>
Using the Post-Processing Menu: Run MySQL Script on Nonroad Output Database

Separate scripts may be run to process output from MOVES Nonroad run. This example is designed to follow completion of a Nonroad run. Setting up a RunSpec for Nonroad is explained in Chapter 7. The scripts are applied to the current output database selected in the current RunSpec.

1. Click **Post Processing > Run MySQL Script on Nonroad Output Database**.

   ![Post Processing Menu](image)

**Note:** Nonroad post-processing scripts may require you run MOVES in a particular way. Ensure you've read the script documentation prior to running MOVES.
2. Select the desired script from the **Select output processing script** drop-down.
3. Read the script’s documentation and confirm your selection by clicking **OK**.
4. Type a name for the post-processing script output in the **File name** field and click **Save**.

**Note:** Use the “.txt” file extension for a plaintext report, or use the “.xls” or “.xlsx” file extension for an Excel report. You must provide the extension at the end of your file name.

5. Depending on the size of the output database and the script selected, this process may take a long time to complete. However, MOVES will notify you when the script has finished and your output has been saved; click **OK**.
### Nonroad Post-Processing Scripts List

<table>
<thead>
<tr>
<th>Script Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EmissionFactors_per_hphr_by_Equipment.sql</td>
<td>Generates emission factors (i.e., emission rates) for each selected pollutant per horsepower-hour by fuel type and equipment type.</td>
</tr>
<tr>
<td>EmissionFactors_per_hphr_by_Equipment_and_Horsepower.sql</td>
<td>Generates emission factors for each selected pollutant per horsepower-hour by fuel type, equipment type, and horsepower bin.</td>
</tr>
<tr>
<td>EmissionFactors_per_hphr_by_SCC.sql</td>
<td>Generates emission factors for each selected pollutant per horsepower-hour by SCC.</td>
</tr>
<tr>
<td>EmissionFactors_per_OperatingHour_by_Equipment.sql</td>
<td>Generates emission factors for each selected pollutant per operating hour by fuel type and equipment type.</td>
</tr>
<tr>
<td>EmissionFactors_per_OperatingHour_by_Equipment_and_Horsepower.sql</td>
<td>Generates emission factors for each selected pollutant per operating hour by fuel type, equipment type, and horsepower bin.</td>
</tr>
<tr>
<td>EmissionFactors_per_OperatingHour_by_SCC.sql</td>
<td>Generates emission factors for each selected pollutant per operating hour by SCC.</td>
</tr>
<tr>
<td>EmissionFactors_per_Vehicle_by_Equipment.sql</td>
<td>Generates emission factors for each selected pollutant per vehicle by fuel type and equipment type.</td>
</tr>
<tr>
<td>EmissionFactors_per_Vehicle_by_Equipment_and_Horsepower.sql</td>
<td>Generates emission factors for each selected pollutant per vehicle by fuel type, equipment type, and horsepower bin.</td>
</tr>
<tr>
<td>EmissionFactors_per_Vehicle_by_SCC.sql</td>
<td>Generates emission factors for each selected pollutant per vehicle by SCC.</td>
</tr>
<tr>
<td>Inventory_by_County_and_Pollutant.sql</td>
<td>Generates an aggregate inventory of each selected pollutant.</td>
</tr>
<tr>
<td>Inventory_by_County_FuelType_Pollutant.sql</td>
<td>Generates an aggregate inventory of each selected pollutant by fuel type.</td>
</tr>
<tr>
<td>Inventory_by_Equipment_Horsepower_Pollutant.sql</td>
<td>Generates an aggregate inventory of each selected pollutant by equipment type and horsepower bin.</td>
</tr>
<tr>
<td>Inventory_by_EquipmentType_Pollutant.sql</td>
<td>Generates an aggregate inventory of each selected pollutant by equipment type.</td>
</tr>
<tr>
<td>Inventory_by_Sector_Horsepower_Pollutant.sql</td>
<td>Generates an aggregate inventory of each selected pollutant by sector and horsepower bin.</td>
</tr>
<tr>
<td>Inventory_by_Sector_SCC_Pollutant.sql</td>
<td>Generates an aggregate inventory of each selected pollutant by sector and SCC.</td>
</tr>
<tr>
<td>Population_by_Sector_and_SCC.sql</td>
<td>Generates population numbers by sector and SCC.</td>
</tr>
</tbody>
</table>
Working with Output Databases in MySQL
You can also use MySQL to manipulate the database output directly. Advice on using MySQL is readily available on the web. Advice specific to MOVES is available in materials such as the Hands-On Training Course for MOVES2014 http://www.epa.gov/otaq/models/moves/documents/moves2014-2day-training-materials.zip.

Copying and Sending MySQL Databases
All input and output databases are stored as folders. These databases can be copied and zipped for email and review.

1. Navigate to your data folder. You may have a shortcut on your desktop labeled “MySQL Data” if you selected this option during MOVES installation. The data location may vary depending on your operating system. The default location for Windows 7+ is C:\ProgramData\MySQL\MySQL Server 5.6\data.
2. Click on the desired database folder; copy and zip if desired.
Chapter 4
Using the MOVES Custom Domain Option
Introduction
When preparing a run at the County or Project scale, users may choose to run a “custom domain”. When using custom domain, access to county default data is unavailable, but you have the ability to model multiple zones (for example, multiple counties, or areas that do not correspond to county boundaries) using the “zone” and “zoneroad” inputs to divide activity between areas of the domain.

Users should first consult Chapter 2 – Using MOVES at the County Scale. This example does not demonstrate all steps involved in creating a custom domain RunSpec.

Inputs for a Custom Domain Run

1. Click **Geographic Bounds**; click the radio button next to **Custom Domain**.

   ![Geographic Bounds](image)

   **Note:** Custom Domain is only available for County and Project Scale RunSpecs.
2. **County ID** is a user defined ID field and can be any number from 1 to 999.

*Note: State ID is always 99 for custom domain; the Description field is optional, but recommended.*
3. Enter the **GPA Fraction**, **Bar. Pressure**, **Vapor Adjust**, and **Spill Adjust**.

![Image showing the MOVES interface with highlighted cells in the County domain for GPA Fraction, Bar. Pressure, Vapor Adjust, and Spill Adjust]

*Note: Numbers shown here are for training purposes only.*
4. Select your database by clicking the **Database** drop-down menu. Or skip to step 5 to create a new input database.
5. Click the **Enter/Edit Data** button to open the County Data Manager (described in detail in Chapter 2). Use the tabs to enter appropriate data for your domain. Zone, zoneroad, zoneSCC, and meteorology are relevant for custom domains. They let you allocate VMT, starts, extended idle, hotelling, and parked (evap) activity across user-defined zones of the domain. Meteorological conditions can also vary across zones. On the other hand, age distribution, fuels, speed distribution, ramp fraction, I/M program, and road type distribution are uniform across all zones in the custom domain and should be entered in the same way as for a county.
Using Zone and Zoneroad Inputs
The zone and zoneroad tables are can be created using the Zone tab in the county data manager.

Zone Input
Zone inputs are used to allocate off-network activity to each zone. Enter the allocation for starts (startAllocFactor) and parking (SHPAllocFactor). The allocations must sum to one for all zones in the domain.

<table>
<thead>
<tr>
<th>zoneID</th>
<th>countyID</th>
<th>startAllocFactor</th>
<th>SHPAllocFactor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>0.1</td>
<td>0.5</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>0.9</td>
<td>0.5</td>
</tr>
</tbody>
</table>

The above example shows a custom domain with two zones. Starts are mostly occurring in zone 2, while extended idle primarily occurs in zone 1. Vehicle hours parked are equally divided between zones 1 and 2.
Zoneroad Input
Zoneroad inputs are used to vary on-road activity by road type and zone. You should enter source hours operating fraction (SHOallocfactor). Some zones may have more activity than others. Also, some zones may have more highway/freeway hours than arterial hours. The factors must sum to one for each road type.

![Table Example](zoneroad_example.xls)

The above example shows two zones with different distributions of VMT. Freeway/highway restricted VMT is mostly in zone 2 while the majority of arterial/local unrestricted VMT occurs in zone 1.
**Meteorology**

Temperature and humidity can vary by zone. Reference county inventory information for guidance on selecting meteorological data sources for MOVES.

The above example shows two zones with different meteorology. Only one hour is shown, but typically a 24-hour profile would be entered for each month and zone being modeled.
Chapter 5
Generate Emission Rates for County Scale Analyses
Introduction
This section describes the process of developing a lookup table of on-road emission rates. It involves several steps including the development of meteorology input, creation of a RunSpec for a rates run, and the development inputs for a rates run. The goal of a rates run is to generate a lookup table of on-road emission rates which can be multiplied by activity estimates to develop an inventory. A MOVES rates run provides five kinds of rates: rateperdistance, ratepervehicle, rateperprofile, rateperstart, and rateperhour. Each of these emission rates is associated with a different type of vehicle activity measurement. To develop a complete onroad emissions inventory that captures all emission processes, you will need to use rates from the rateperdistance, ratepervehicle, and rateperprofile tables. In some cases, as described below, you may choose to substitute rates from the rateperstart and/or rateperhour tables for some of the processes in the ratepervehicle table.

Types of Emission Rates Associated with Each MOVES Process

<table>
<thead>
<tr>
<th>ID</th>
<th>Emission Process</th>
<th>Type of Emission Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Running Exhaust</td>
<td>Distance</td>
</tr>
<tr>
<td>2</td>
<td>Start Exhaust</td>
<td>Vehicle or Start</td>
</tr>
<tr>
<td>9</td>
<td>Brakewear</td>
<td>Distance</td>
</tr>
<tr>
<td>10</td>
<td>Tirewear</td>
<td>Distance</td>
</tr>
<tr>
<td>11</td>
<td>Evap Permeation</td>
<td>Distance and Vehicle</td>
</tr>
<tr>
<td>12</td>
<td>Evap Fuel Vapor Venting</td>
<td>Profile</td>
</tr>
<tr>
<td>13</td>
<td>Evap Fuel Leaks</td>
<td>Distance and Vehicle</td>
</tr>
<tr>
<td>15</td>
<td>Crankcase Running Exhaust</td>
<td>Distance</td>
</tr>
<tr>
<td>16</td>
<td>Crankcase Start Exhaust</td>
<td>Vehicle or Start</td>
</tr>
<tr>
<td>17</td>
<td>Crankcase Extended Idle Exhaust</td>
<td>Vehicle</td>
</tr>
<tr>
<td>18</td>
<td>Refueling Displacement Vapor Loss</td>
<td>Distance and Vehicle</td>
</tr>
<tr>
<td>19</td>
<td>Refueling Spillage Loss</td>
<td>Distance and Vehicle</td>
</tr>
<tr>
<td>90</td>
<td>Extended Idle Exhaust</td>
<td>Vehicle or Hour</td>
</tr>
<tr>
<td>91</td>
<td>Auxiliary Power Exhaust</td>
<td>Vehicle or Hour</td>
</tr>
</tbody>
</table>

Understanding the Five Types of MOVES Rates

Rateperdistance
Rateperdistance is used for on-road running processes—that is, exhaust and most evaporative emissions that happen on “real” roadtypes, plus refueling associated with energy expended on the roads. The units are in grams per vehicle-mile. The output rateperdistance table reports a rate for each temperature and each of the 16 speed bins. The temperature range will depend on your defined meteorology input. MonthID depends upon the selection in the RunSpec. **Inventory estimates are calculated from rateperdistance by multiplying the VMT at a given speed by the emission rate at that speed and ambient temperature.** Rates will always be reported for each speed bin 1-16 corresponding to 0 mph to 72.5+ mph.

The image below describes MOVES speed bins 1-16.
To develop rates, use temperature ranges in even intervals to produce a lookup table. For example, Hour 1 – 50 degrees, Hour 2 – 51 degrees, Hour 3 – 52 degrees, etc. A rate will be produced for each temperature; the hourID does not impact the results. Similarly, monthID is meaningless (assuming appropriate fuels are imported). Additional monthIDs can be defined to expand the temperature range (e.g., two months would allow 48 temperature intervals). Using this approach, you can develop a lookup table of running emission rates that covers all possible temperatures that occur in the modeling domain.

**Ratepervehicle**
Ratepervehicle is used for exhaust and most evaporative emissions that occur Off-Network (roadtype=1), such as starts, extended-idle, and Auxiliary Power Unit (APU) processes. The units are in grams per vehicle. The output ratepervehicle table reports a rate for each temperature and hour. For start, extended idle, and APU rates, the temperature and hour of day impact the calculated emission rate. You define the temperature profile through the meteorology input. **Inventory estimates are calculated by multiplying the rate by the total vehicle population, not the number of starts or hotelling-hours.**

To develop rates, input a realistic diurnal profile since both temperature and hour of day impact the emission rate. For example, Hour 1 – 50.1 degrees, Hour 2 – 51.6 degrees, Hour 3 – 54.4 degrees, etc. A rate will be produced for each temperature/hourID. The monthID is meaningless (assuming appropriate fuels are imported). Additional monthIDs can be defined to allow multiple diurnal profiles (e.g., two months would allow two diurnal profiles).

**Rateperprofile**
Rateperprofile is used for evaporative vapor venting. The units are in grams per vehicle. The output rateperprofile table reports a rate for each temperature and hour. For vapor venting rates, the emission rate for a given temperature and hour of the day is affected by the temperature in previous hours. You define the temperature profile through the
meteorology input. **Inventory estimates are calculated by multiplying the rate by the total vehicle population, not the number of parked hours.**

The image below indicates example temperature profiles. In this example, even though the temperatures at hour 15 are identical for Profile 2 and Profile 3, the evaporative emissions rates for that hour will be different because of temperature differences in previous hours.

To develop rates, input a realistic diurnal profile since the temperature and previous hour’s temperature impact the emission rate. For example, Hour 1 – 50.1 degrees, Hour 2 – 51.6 degrees, Hour 3 – 54.4 degrees, etc. A rate will be produced for each temperature/hourID. MonthID is meaningless (assuming appropriate fuels are imported). Additional monthIDs can be defined to allow multiple diurnal profiles (e.g., two months would allow two diurnal profiles).

**Rateperhour**
Rateperhour is an alternate rate to use for the Extended Idle, Crankcase Extended Idle, and APU process when good data are available for this activity. The units are in grams per APU operating hour. **Inventory results are calculated by multiplying the APU rate by the hours of APU operation, and the Extended Idle by the hours of extended idle hours.**

**Rateperstart**
Rateperstart is an alternate rate to use for the start exhaust and crankcase start exhaust processes when good data are available for vehicle starts. The units are in grams per
vehicle start. **Inventory results are calculated by multiplying the rate by the number of starts.**

**Creating a RunSpec for a Rates Run**

1. Click **Description** and enter your RunSpec information (up to 5,000 characters of text, but no quote, ampersand or backslash characters allowed).
2. Select **Scale**; click the **County** radio button.
3. Click the **Emission Rates** radio button; type in your MOVESScenarioID.

**Note:** MOVESScenarioID is required for a rates run, but is only used if MOVES output is post-processed with a specific application.
4. Click **Time Spans**; select a year from the **Select Year** drop-down; click **Add**.
5. Click one or more checkboxes in the **Months** box.

**Note:** For rates runs, month is used to indicate different fuel and/or meteorological conditions as determined by your inputs. Click **Select All** to select all 12 months. Click **Clear All** to remove all selections.
6. Select one or more day types in the **Days** box.

Note: You can also click Select All to select all options. Click Clear All to remove all selections. Start/evap rates will vary by day type. An annual inventory should use rates for weekend and weekdays. Daily inventory may use only weekdays.
7. Select all the hours in the **Hours** box using the dropdown menu.

**Note:** You can also click **Select All** to select all the hours. Click **Clear All** to remove all selections.
8. Click **Geographic Bounds**; verify the radio button is selected next to **Zone & Link**.

**Note:** Select the radio button next to **Custom Domain** if applicable. Custom domain can add additional flexibility using the zone input. It is possible to model many temperature ranges and diurnal profiles with separate zoneIDs.
9. Click on a state in the **States** box.

**Note:** Only one State can be selected for County scale RunSpecs.
10. Click a county in the **Counties** box; click **Add**.

**Note:** Only one county can be selected for County scale RunSpecs.

11. Click **Vehicles/Equipment**.
Generate Emission Rates for County Scale Analyses
12. Click **On Road Vehicle** Equipment; select all vehicle/fuel types present in the modeling domain in the **Fuels** box.

**Note:** To select multiple fuels, hold the <ctrl> button and click each desired fuel type. Click the **Select All** button to select all fuel types.
13. Select the desired source use types in the **Source Use Types** box; click **Add Fuel/Type Combinations**.

**Note:** To select multiple source use types, hold the <ctrl> button and click each desired source use type. Click the **Select All** button to select all source use types.
14. Click **Road Type**.
15. Select all road types present in the modeling domain in the **Available Road Types** box; click **Add**.

**Note:** To select multiple road types, hold the <ctrl> button and click each desired road type. Click the **Select All** button to select all road types.
16. Click **Pollutants and Processes**.
17. Select all pollutants of interest by clicking the desired boxes.

**Note:** For a complete inventory, all processes must be selected. A rate is produced for each pollutant and process (expressed as rateperdistance, ratepervehicle, rateperprofile, rateperhour, or rateperstart).
18. Click **Manage Input Data Sets**.

**Note:** You don’t need to enter data in this section, but you must click to change the indicator to a green checkmark.
19. Click **Output**; click **General Output**.
20. Type your output database name in the **Database** field; click **Create Database**.

**Note**: If you are using a previously created database, choose it from the **Database** drop-down menu.
21. Select **Grams, Joules, and Miles** from the **Units** drop-down menus.

**Note:** For rates, the model automatically generates output for Activity output for Distance Traveled, Hotelling, Population and Starts.
22. Click **Output Emissions Detail**.
23. Click the checkbox in the **On and Off Road** box that pertains to your RunSpec.

**Note:** Emission Process and Road Type are automatically selected. Additional selections depend upon your available activity data and preference.
Developing Inputs for a Rates Run

**Meteorology**
Meteorology is used to define the range of rates produced. A rate is generated for every temperature defined. Each month selected in the RunSpec allows 24 temperatures to be defined (hours 1-24). Typically, multiple months are selected to allow a complete range of temperatures for rateperdistance as well as several diurnal profiles for ratepervehicle/rateperprofile/rateperstart/rateperhour rates. **MonthID is meaningless in a rates run as long as the appropriate fuel is applied to correct month.**

**SourceTypePopulation**
Population is applied to the ratepervehicle and rateperprofile rates in your post-processing. A vehicle population should be entered that is reasonable and consistent with VMT. One option is to enter the total vehicle population of the modeling domain. Alternatively, a single county’s vehicle population can be used. Most importantly, the ratio to VMT must reflect actual conditions.

**Age Distribution**
Enter the Age Distribution of the modeling domain. If you want to apply your rates to multiple counties, use a single age distribution that is appropriate for all those counties. If you have multiple counties with different age distributions you could model each county separately. Alternatively, if you, if you select the model year output emissions detail, the model will produce rates for each model year which then can be post-processed to account for varying age distribution across a multi-county domain. Note that this approach will produce extremely large output files.

**VMT (HPMSVTypeYear)**
VMT is applied to the rateperdistance rates in your post-processing. A VMT should be entered that is reasonable and consistent with vehicle population. One option is to enter the total VMT of the modeling domain. Alternatively, a single county’s VMT can be used. Most importantly, the ratio to vehicle population must reflect actual conditions.

**VMT (month, day, and hour fractions)**
MonthVMTfraction, dayVMTfraction, and hourVMTfraction are also required by MOVES. These fractions impact emission rate calculations. Reasonable values should be entered - either local fractions or MOVES defaults.

**Speed Distribution**
Emission rates for rateperdistance will be produced for each of 16 speed bins. MOVES still requires an average speed distribution input. This should be a reasonable distribution - either local distribution or MOVES defaults.

**Road Type Distribution**
Emission rates for rateperdistance will be produced for each road type. MOVES still requires a road type distribution input. This should be a reasonable distribution - either local distribution or MOVES defaults. A value of zero should always be entered for the off-network road type (road type 1).
**Ramp Fraction**
Input the local ramp fraction or use the MOVES default (0.08) if none is available. Emission rates for rateperdistance will include ramp activity within each of the 16 speed bins. MOVES accounts for the activity required to accelerate to the average speed of each bin. Ramp VMT should be added to freeway/highway VMT for post-processing.

**Fuels**
Input the fuel supply and fuel formulations used in the modeling domain. Rates cannot be applied to areas that use different fuels. Fuels should correspond to the temperature profile for a given month. For instance, a wintertime diurnal temperature profile using the MonthID = 7 should not use July fuels.

If you choose output that does not distinguish rates by fuel type, your mix of gasoline/diesel/CNG will be determined by the default AVFT (i.e. the fuel type and technology allocations) automatically selected in the CDM, or your inputs to override these default values. However, if you select output that is distinguished by fuel type, the AVFT values will not be applied, and instead you will apply an appropriate mix of activity by fuel type during your post-processing.

**I/M Programs**
Input the Inspection and Maintenance program used in the modeling domain. Rates cannot be applied to areas that have a different I/M program or different compliance rates.
Chapter 6
Using MOVES at the Project Scale
**Introduction**

In this section, you will explore MOVES capabilities at the Project Scale. Project Scale estimates emissions at the link level. Links are defined by the user and can include roadway links, such as sections of highway, ramps, arterial roads, or individual intersection segments and Off-Network links, which include start and extended idling activity. Project Scale models the average conditions on one or more links; it does not perform traffic simulation modeling. It utilizes the same MOVES emission rates and correction factors as County and National Scale. It does not utilize the default MOVES growth, VMT, or population values – you must supply these values, as well as all information necessary to define the links and the activity on them. Data can be exported or imported with the Project Data Manager (PDM).

Project Scale analysis may be appropriate for activities such as CO and PM Hot-Spot analysis for conformity, environmental impact assessments, and roadway/intersection level energy and GHG analysis. Nonroad runs do not work at the Project Scale. EPA has developed guidance for quantitative PM Hot-Spot analysis for conformity and using MOVES for CO project scale analysis. Both documents can be found online at: [http://www.epa.gov/otaq/stateresources/transconf/policy.htm](http://www.epa.gov/otaq/stateresources/transconf/policy.htm).

EPA has also developed a training course specific to the PM Hot-Spot requirement in the conformity rule. Training covers using MOVES in accordance with EPA guidance. It also covers air quality modeling, background concentrations, and design values, along with other topics. Training materials and training dates/locations can be found online at: [http://www.epa.gov/otaq/stateresources/transconf/training3day.htm](http://www.epa.gov/otaq/stateresources/transconf/training3day.htm).

This User Guide provides a brief outline of how to use MOVES at the Project Scale. The example scenario used here has been simplified. You should consult the guidance documents and training listed above before doing a Project Scale analysis for any regulatory purpose.
Creating a Project Scale RunSpec

1. Click **Description** and enter your RunSpec information (up to 5,000 characters of text, but no quote, ampersand or backslash characters allowed).
2. Click **Scale**; select the **Project** radio button under **Domain/Scale**.
3. Choose the **Inventory** radio button under **Calculation Type**.

**Note:** Either the Inventory or the Emission Rates option may be used. Chapter 5 provides more information on MOVES emission rates.
4. Click **Time Spans**.

![Image of Time Spans](image)

**Note:** In Project Scale, each run can only consist of a single year, month, day, and hour.
5. Under **Years**, select a year from the **Select Year** drop-down menu; click **Add**.
6. Under **Months**, select a month by clicking the box. A checkmark will appear in the box next to the selected month.
7. Under the **Days** section, choose your option by clicking the box next to **Weekend** or **Weekdays**. A checkmark will appear in the box next to the selected options.
8. Under **Hours**, choose the desired hour from the **Start Hour** drop-down menu. Select the same hour as the **End Hour** (one hour timeframe only).
9. Click **Geographic Bounds**; select the **County** radio button. In Project Scale, each run can only be done for a single county or custom domain.

**Note:** Choosing a county allows access to the default data stored for that county.
10. Select a state from the **States** drop-down menu.
11. Select one county from the **Counties** drop-down menu; click **Add**.

**Note:** You may select one county only. An input database must be created or selected to store the project specific data (done later).
12. Click **Vehicles/Equipment**; click **On Road Vehicle Equipment**.
13. Select a fuel (or fuels) from the **Fuels** list.

**Note**: Selections chosen are for training purposes. For most analyses, select all valid gasoline, diesel, Ethanol, and CNG vehicle combinations that would use the links you are modeling.
14. Select a source use type (or types) from the **Source Use Types** list; click **Add Fuel/Type Combinations**.

**Note:** You can select multiple source use types by holding the `<crtl>` button while clicking your selections. Your selections will appear in the **Selections** list after you click **Add Fuel/Type Combinations**.
15. Click **Road Type**; select a road type (or types) from the **Available Road Types list**; click **Add**.

**Note**: Select only the road types that exist in the project you are analyzing. Select Off-Network only if the project includes starts or extended idle activity.
16. Click **Pollutants and Processes**; click the box next to each pollutant you’d like included in your RunSpec.

**Note:** Evaporative Processes cannot be modeled using the Project Scale.
17. Click **Manage Input Data Sets**.

**Note:** You need to click on this panel to get a green check, but no other input is needed. You would use this panel if you had specialized input data created outside of MOVES. The Project Data Manager is generally a better option.
19. Click **Output**; click **General Output**.

**Note:** You must define an output database.
20. Type your output database name in the **Database** field.

![Database Field](image)

**Note**: We recommend naming your output database ending with “_out”.

**Note**: You can also use the drop-down to locate an existing database if you’ve previously created one. Output from multiple RunSpecs can be stored in the same output database. Each RunSpec will be identified in your output with a different MOVESrunID.
21. Click the drop-downs under **Units** to identify **Mass Units, Energy Units, and Distance Units**.

**Note**: Values must be selected for all three types of units.
22. **Optional step**: Click the box (or boxes) next to the activity (or activities) under the **Activity** section you’d like in your output.

**Note**: Selections shown are for training purposes, but are recommended for any inventory RunSpec.
23. Click **Create Database**.
24. You will receive a pop-up message letting you know your output database was successfully created. Click **OK**.
25. Click **Output Emissions Detail**.
26. Under **for All Vehicle/Equipment Categories**, click the box (or boxes) next to you’re the detail you want in your output.
27. Under **On Road and Off Road**, click the boxes next to the details you’d like in your output.
28. Optional step. Click **Advanced Performance Features Panel**. This section is for advanced users and troubleshooting only. Most users will not populate this screen.
Using the Project Data Manager

The Project Data Manager (PDM) is a tool that facilitates the process of entering data into an input database. It can only be used for an on-road run (there is no nonroad project level available). The data in the input database is used by MOVES when executing the RunSpec. When the PDM is open, the MOVES GUI is frozen and no changes can be made to the RunSpec.

You will manipulate your data in Excel and then import those worksheets into the PDM. You do not enter data directly into the PDM. The PDM can create templates, export default data, or export previously imported data. The files you create through the PDM are in the format required for the input tables, which is very important.

You can add descriptions of the imported data which are useful for documenting data sources. You can also clear previously imported data before importing new data to ensure accuracy and prevent execution errors.

There are two ways to open the PDM.

1. Click **Pre Processing > Project Data Manager**.
2. Click **Geographic Bounds** then click **Enter/Edit Data**.

![Image of Geographic Bounds and Enter/Edit Data in MOVES software]
A newly opened PDM has many tabs at the top, as shown in the image below.

Note: Appears when data is sufficient and passes error checks for all parameters in the RunSpec.  Appears when insufficient data is provided and/or there are errors. However, for some project scale runs, it is acceptable to have a red X for some tabs. For instance, for project scenarios with no off-network links, it is unnecessary to define an Off-Network, Hotelling, and Operating Mode Distribution input. Also, the I/M Programs tab will remain a red X if no program is defined; which may be appropriate for some areas.
Using the Project Data Manager: Database Tab

The Database tab is where you create or select the input database. Once you’ve selected or created an input database, the tables within it can be edited with the other PDM tabs.

1. To create a database, type a database name in the Database field (or select an existing one from the drop-down menu).

Note: End all database file names with ‘_in’ to help identify them as input databases. Once a database is created or chosen, the other tabs are available for inputs.

Note: Use a consistent naming convention by giving the input database a similar name to the RunSpec file and output database. Previously created input databases will appear in the drop-down menu and can be opened for editing.
2. Click **Create Database**.

![Database creation screenshot](image)

**Note:** All tables in the selected database can be cleared of data by clicking the **Clear All Imported Data** button.
3. Click **OK**.
Using the Project Data Manager: Creating a Template

You can create an Excel template spreadsheet from most tabs in the PDM. The template will be pre-populated with some data based upon entries made in your RunSpec. The fields/column headings will be created, but the cells will be blank for your own data.

1. Click the **Create Template** button.
2. Type a name for the template in the **File name** field.

**Note:** Use the “.xls” or “.xlsx” file extension at the end of your file name. You can open and edit the file in Excel.
3. Click **Save**.

**Note:** Ensure you’ve navigated to the folder where you want to store the template.

**Note:** After creating and saving the blank template, you would then open it in Excel, enter the appropriate local data, and save again prior to importing the completed data into MOVES. The process of finding the completed input spreadsheet and importing it into MOVES is described below.
Using the Project Data Manager: Exporting Default Data
Not all tabs in the PDM have the Export Default Data option. When the option is available, an Export Default Data will be present on the GUI. To export data when available, follow the steps below.

1. Click the **Export Default Data** button.
2. Type a name for the data file in the **File name** field.

**Note:** Use the “.xls” or “.xlsx” file extension at the end of your file name. You can open and edit the file in Excel. We recommend that you use descriptive file names that will make it easier to keep track of what files provide local data for your MOVES run.
3. Click **Save**.

**Note:** Ensure you’ve navigated to the folder where you want to store the data file.

**Note:** After exporting and saving default data, you would then open it in Excel, review and make any changes needed to properly reflect local data, and save again prior to importing the modified data into MOVES. The process of finding the modified data and importing it into MOVES is described below.

**Viewing Defaults and Entering Data**

Once you have saved moves defaults or a blank template, you may view and edit these values with Excel. Using the template or defaults will assure that you have correct worksheet and column names.

For guidance on data sources and other requirements, see the most recent MOVES technical guidance on using MOVES to prepare emission inventories in State Implementation Plans and Transportation Conformity available on the web at [http://www.epa.gov/otaq/models/moves/index.htm](http://www.epa.gov/otaq/models/moves/index.htm)
Using the Project Data Manager: Importing Data
Data must be imported back into the PDM from Excel for each required tab (even when using default data for a tab). Use the templates and default data described above to make sure the data is properly formatted.

Tabs indicated by a ❌ may require more information. Tabs with a ✅ are optional for user supplied data.

The following steps are shown for the Hotelling tab, but need to be repeated for each of the required tabs in the following table. Some inputs are not used for certain projects (e.g. a project with no off-network activity will not use the Hotelling, and Off-Network tabs)

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Tab Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hotelling</td>
<td>This tab allows input of the operating distribution for vehicles during hotelling hours. Time can be divided between extended idling, APU operation, and engine OFF. The MOVES table is hotellingActivityDistribution.</td>
</tr>
<tr>
<td>I/M Programs</td>
<td>This tab allows input of data on I/M programs, if any exist. The MOVES table is IMCoverage.</td>
</tr>
<tr>
<td>Operating Mode Distribution</td>
<td>This tab allows input of the operating distribution for vehicles during starts and running operation. The MOVES table is opModeDistribution.</td>
</tr>
<tr>
<td>Age Distribution</td>
<td>This tab allows input of the distribution of vehicles by age. Each source type combination has its own distribution by age. The MOVES table is sourceTypeAgeDistribution.</td>
</tr>
<tr>
<td>Fuel</td>
<td>This tab allows input of information about the fuel supply, fuel formulations, fuel usage, and AVFT (i.e. the fuel and technology distribution). The MOVES tables are fuelSupply, fuelFormulation, fuelUsageFraction, and AVFT.</td>
</tr>
<tr>
<td>Meteorology Data</td>
<td>This tab allows input of temperature and humidity inputs. The MOVES table is ZoneMonthHour.</td>
</tr>
<tr>
<td>Links</td>
<td>This tab allows input of definitions of the road segments (i.e. “links”) within the project domain. The MOVES table is link.</td>
</tr>
<tr>
<td>Link Source Types</td>
<td>This tab allows input of allocation of activity by source type. Each source type's activity fraction within the project's single hour on each link is expressed. The MOVES table is linkSourceTypeHour.</td>
</tr>
<tr>
<td>Off-Network</td>
<td>This tab allows input of population and activity fractions for each source type present in the off-network link. Each project domain can have at most one off-network link. The MOVES table is offnetworkLink.</td>
</tr>
</tbody>
</table>
1. Click the **Hotelling** tab.

**Note:** Reference EPA guidance documents and training for additional information about using the Project Data Manager.
2. Click **Browse**.
3. Click the Excel file with the data you want to import; click Open.
4. Click the worksheet to use (should match Data Source in the PDM tab); click **OK**.
5. Add a description for the imported data in the **Description of Imported Data** field; click **Import**.

**Note:** We recommend that users add a description of the imported data. This will appear in the log and can help you differentiate between multiple imported files.
6. Verify the file was imported by clicking the **Database** tab to view the log.

You must do this for each required tab. Click each required tab, then complete steps 2-6 outlined above. Finally, click “Done” and return to the main MOVES GUI.
Executing the RunSpec
The RunSpec is ready once all information has been entered and imported. You will see green checkmarks next to each option on the left side of the GUI.

1. Click **Geographic Bounds**.

   ![Geographic Bounds screenshot]

   **Note**: If **Geographic Bounds** doesn’t show with a green checkmark, refresh the screen by clicking **Time Spans** (or any other menu item) and then go back to **Geographic Bounds**. It should now be green.
2. Verify the correct input database is selected.
3. Click **Action > Execute**.
4. Click **Yes** to save the RunSpec before executing.
5. MOVES is now executing your RunSpec. Two windows will pop-up during execution, but require no action on your part.

Note: Estimated time of completion is shown in the Estimated Time Remaining window pop-up.
6. Click **OK** when the **Run Completion** window appears.
Introduction
In this section, you will learn to use MOVES to generate emission inventories for nonroad equipment such as tractors, lawnmowers, recreational boats and other mobile sources that do not generally operate on roadways. MOVES2014a incorporates an updated fuels database and new output options compared to MOVES2014.

Creating a Nonroad RunSpec
1. Click **Description** and enter your RunSpec information (up to 5,000 characters of text, but no quote, ampersand or backslash characters allowed).

![Image of MOVES interface showing Description section]

Note: This training scenario is intentionally simplified to facilitate learning.
2. Click **Scale**; select the **Nonroad** radio button under **Model**.
3. Click **Time Spans**.
4. Under **Years**, select a year from the **Select Year** drop-down menu; click **Add**.

**Note**: To keep output size manageable, we recommend modeling only one year at a time for nonroad.
5. Under **Months**, select a month (or months) by clicking the box. A checkmark will appear in the box next to the selected month(s).

**Note:** You may click **Clear All** to remove the checkbox in this section.
6. Under the **Days** section, choose your option by clicking the box next to **Weekend** and/or **Weekdays**. A checkmark will appear in the box next to the selected options.

**Note**: If you make an error in your choice, you may also click **Clear All** to remove the checkbox in this section.
7. Click **Geographic Bounds**; select the **County** radio button.
8. Select a state from the **States** scrollable list. This action will populate the **Counties** scrollable list.

*Note:* The selections chosen are for training purposes only. You may choose one or more states.
9. Select a county from the **Counties** list; click **Add**. Your choice should then appear in the **Selections** box.

**Note:** You may select one or more counties.
10. Click **Vehicles/Equipment**; click **NonRoad Vehicle Equipment**.
11. Select a fuel (or fuels) from the **Fuels** list.

**Note:** Selections chosen are for training purposes. For most analyses, select all valid combinations.
12. Select a sector (or sectors) from the **Sectors** list; click **Add Fuel/Sector Combinations**. This action should populate the **Selections** box.

**Note**: You can select multiple source use types by holding the `<ctrl>` button while clicking your selections. Your selections will appear in the **Selections** list after you click **Add Fuel/Sector Combinations**. The model will only allow selected combinations which exist in the database. Unlike MOVES2014-Nonroad, non-existent combinations will not be included in the RunSpec.
13. Click **Road Type**.

**Note:** Selections are already populated for you.
14. Click **Pollutants and Processes**; click each checkbox on the left to choose all processes for a pollutant.

**Note**: Items chosen are for training purposes, but all pollutants and processes are generally chosen for Nonroad RunSpecs. Uncheck to remove or click the **Clear All** button to remove all selections. Some pollutants (e.g., VOC) require selecting other pollutants (e.g., non-methane hydrocarbons). Click the **Select Prerequisites** button to automatically include necessary pollutants to model your intended pollutants.
15. Click **Manage Input Data Sets. Skip this step if you do not have outside data to import.** Click the **Database** drop-down menu to choose your database; click **Add.** If you create a new input database since the GUI was last opened, click the **Refresh** button to ensure the **Database** drop-down menu can read the most recent list of databases on your server. If you add multiple databases, you can change the order in which they appear under the **Selections** box by clicking the **Move Up** or **Move Down** button. Click **Delete** to remove a database from the **Selections** box.
16. The only current Strategy is Rate of Progress. These calculations are not relevant for Nonroad equipment.
17. Click **Output**; click **General Output**.

**Note**: You must identify an output database.
18. Type your output database name in the **Database** field. Alternatively, choose an existing output database name by clicking the downward triangle to show the drop-down menu of databases available.

**Note:** We suggest you name your output database ending with “.out”.

**Note:** You can also use the drop-down to locate an existing database if you’ve previously created one. Results of multiple RunSpecs can be stored in the same output database. The results of each RunSpec will be identified by a different MOVESrunID.
19. Click the drop-downs under **Units** to identify **Mass Units**, **Energy Units**, and **Distance Units**.

**Note**: Values must be selected for all three Units fields.
20. Click **Create Database**.
21. You will receive a pop-up message letting you know your output database was successfully created. Click **OK**.
22. Click **Output Emissions Detail**. The **Always** pane shows three checkboxes that are always checked: **Time**, **Location**, and **Pollutant**. Next to the **Time** checkbox is a dropdown menu with only one option for time aggregation of the outputs: **24-Hour Day**. The default setting for **Location** dropdown menu is the same selection you specified previously under the **Geographic Bounds** section of the Navigation Panel. Leave the Location set to **County**. You could also choose **State** or **Nation**.
23. **For All Vehicle/Equipment Categories** provides options of additional detail of emission results. Not checking these boxes tells MOVES to aggregate the results across all model years, fuel types, and/or emissions processes. Model Year breaks down emissions for each of 50 model years for each equipment type. Fuel Type and Fuel Subtype break down emissions by fuel type and subtype. Emission Process breaks down emissions by the emission processes in the Pollutants and Processes Panel. Checking any or all the boxes in this and the following two sections can result in extremely large output files that may require a lot of post-processing. You should think carefully about how much detail you really need in your output before making selection in this panel. In general, we do not recommend selecting Model Year.
24. Under **On Road and Off Road**, there is currently only one available option – SCC, which stands for Source Classification Code – a system that EPA uses to classify emission sources.
Under **Off Road**, MOVES2014a offers three options for disaggregating output. Sector separates output by the sectors that are given in the NonRoad Vehicle Equipment panel described above. Engine Tech. separates emissions by different types of engine technology, for example 2-stroke vs. 4-stroke gasoline engines. HP Class breaks down emissions by horsepower bins. Checking either or both of the Engine Tech. and HP Class boxes has the potential to add many additional lines to the output file and you should think carefully about how much detail you really need in your output before making selection in this panel.
25. **Optional step.** Click **Advanced Performance Features Panel.**

**Note:** This section is for advanced users and troubleshooting only. Most users will not populate this screen.
26. *Optional Step* to import local Nonroad data. Click **Pre Processing** in the menu and select **Nonroad Data Importer**.
27. The Nonroad Data Importer opens on the **Database** tab by default. There are two available tabs: **Fuel** and **Meteorology Data**.
28. Enter a database name. Alternatively, you can use the dropdown menu to find an existing Nonroad input database.
29. After entering a database name, click the **Create Database** button. You will receive pop up confirmation that the database was successfully created.
30. Click **OK**.
31. Click the **Fuel** tab. You will see the Fuels Wizard, the Nonroad Fuel Supply importer, and the Fuel Formulation importer in the window.
32. **Optional Step.** Click **Export Default Data.**
33. Navigate to desired directory, and then type a file name for the default fuels data. Click **Save**. You can now modify the default fuel data as appropriate to reflect local fuel properties by editing the Excel file that you created.
34. Under **nrFuelSupply Data Source**, click **Browse**.
35. Select the file containing fuels data, then click **Open**.
36. Choose `nrFuelSupply` as the XLS Worksheet, and click OK.
37. Under **FuelFormulation Data Source**, click **Browse**.
38. Select the file containing fuels data, then click **Open**.
39. Choose **FuelFormulation** as the XLS Worksheet, and click **OK**.
40. Click **Import**.
41. Click the **Meteorology Data** tab. Under **zoneMonthHour Data Source**, click Create Template..... Give the template file an appropriate name and save it as an Excel file. Open that Excel file, fill in the new local temperature and humidity data that you plan to use, and save the file.
42. Select the file containing your meteorology data by clicking to highlight, and then click **Open**.
43. Select **ZoneMonthHour** as the XLS Worksheet, and click **OK**.
44. Click **Import**.
45. **Optional Step.** Click the **Generic** tab. Here, you can replace any table in the MOVES default database with another version, by clicking the dropdown menu to indicate the table to upload. However, most of the tables do not apply to the Nonroad model. *(hint: the tables which start with the letters “nr” are nonroad tables).* Replacing default tables through the **Generic** tab requires advanced knowledge of the MOVES database and it is not recommended that the typical user attempt to replace default nonroad tables other than fuel or meteorology related tables using the Fuel and Meteorology tabs as described above.
46. Click the **Database** tab to review the log of imported data. Then click **Done** to exit the Nonroad Data Importer and return to the GUI.
Running MOVES for Nonroad
After creating and saving your Nonroad RunSpec, you may **Execute** it from the **Action** menu or the command line. When the run is complete, the **Post Processing** menu offers scripts to process and aggregate the MOVES nonroad output as described in Chapter 3.
## MOVES Onroad Decoder

Many of the tables used by MOVES contain data that are identified using numerical codes for categorical values. This appendix lists descriptions for some of the most important codes for highway vehicles used in MOVES tables.

All the codes for both highway vehicles and nonroad are described in the default MOVES database, generally in a table with the same name as the value. (For example, fuel subtypes used for nonroad equipment are described in the table “nrfuelsubtype”.)

<table>
<thead>
<tr>
<th>sourcetypeid</th>
<th>processid</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
<td><strong>ID</strong></td>
</tr>
<tr>
<td>sourcetypename</td>
<td>processName</td>
</tr>
<tr>
<td>11 Motorcycle</td>
<td>1 Running Exhaust</td>
</tr>
<tr>
<td>21 Passenger Car</td>
<td>2 Start Exhaust</td>
</tr>
<tr>
<td>31 Passenger Truck</td>
<td>9 Brakewear</td>
</tr>
<tr>
<td>32 Light Commercial Truck</td>
<td>10 Tirewear</td>
</tr>
<tr>
<td>41 Intercity Bus</td>
<td>11 Evap Permeation</td>
</tr>
<tr>
<td>42 Transit Bus</td>
<td>12 Evap Fuel Vapor Venting</td>
</tr>
<tr>
<td>43 School Bus</td>
<td>13 Evap Fuel Leaks</td>
</tr>
<tr>
<td>51 Refuse Truck</td>
<td>15 Crankcase Running Exhaust</td>
</tr>
<tr>
<td>52 Single Unit Short-haul Truck</td>
<td>16 Crankcase Start Exhaust</td>
</tr>
<tr>
<td>53 Single Unit Long-haul Truck</td>
<td>17 Crankcase Extended Idle Exhaust</td>
</tr>
<tr>
<td>54 Motor Home</td>
<td>18 Refueling Displacement Vapor Loss</td>
</tr>
<tr>
<td>61 Combination Short-haul Truck</td>
<td>19 Refueling Spillage Loss</td>
</tr>
<tr>
<td>62 Combination Long-haul Truck</td>
<td>90 Extended Idle Exhaust</td>
</tr>
<tr>
<td>8 2BHDDV</td>
<td>91 Auxiliary Power Exhaust</td>
</tr>
<tr>
<td>9 LHDDV</td>
<td>99 Well-to-Pump</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SCCVtypeID</th>
<th>roaddesc</th>
<th>dayID</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ID</strong></td>
<td><strong>ID</strong></td>
<td><strong>ID</strong></td>
</tr>
<tr>
<td>PART5SCCVtypeDesc</td>
<td>roaddesc</td>
<td>dayName</td>
</tr>
<tr>
<td>1 LDGV</td>
<td>1 Off-Network</td>
<td>2 Weekend</td>
</tr>
<tr>
<td>2 LDGT1</td>
<td>2 Rural Restricted</td>
<td>5 Weekdays</td>
</tr>
<tr>
<td>3 LDGT2</td>
<td>3 Rural Unrestricted</td>
<td></td>
</tr>
<tr>
<td>4 HDGV</td>
<td>6 Rural Restricted w/o ramps</td>
<td></td>
</tr>
<tr>
<td>5 MC</td>
<td>7 Urban Restricted w/o ramps</td>
<td></td>
</tr>
<tr>
<td>6 LDDV</td>
<td>8 Rural Restricted Ramps</td>
<td></td>
</tr>
<tr>
<td>7 LDDT</td>
<td>4 Urban Restricted</td>
<td></td>
</tr>
<tr>
<td>8 2BHDDV</td>
<td>5 Urban Unrestricted</td>
<td></td>
</tr>
<tr>
<td>9 LHDDV</td>
<td>9 Urban Restricted Ramps</td>
<td></td>
</tr>
<tr>
<td>regClassID</td>
<td>regClassName</td>
<td>regClassDesc</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td>0</td>
<td>Doesn’t Matter</td>
<td>Doesn’t Matter</td>
</tr>
<tr>
<td>10</td>
<td>MC</td>
<td>Motorcycles</td>
</tr>
<tr>
<td>20</td>
<td>LDV</td>
<td>Light Duty Vehicles</td>
</tr>
<tr>
<td>30</td>
<td>LDT</td>
<td>Light Duty Trucks</td>
</tr>
</tbody>
</table>
| 40         | LHD <= 10K   | Class 2b Trucks with 2 Axles and 4 Tires  
(8,500 lbs < GVWR <= 10,000 lbs)  
Class 2b Trucks with 2 Axles and at least 6 Tires or Class 3  
(8,500 lbs < GVWR <= 14,000 lbs) |
| 41         | LHD<=14k     | Trucks  
(8,500 lbs < GVWR <= 14,000 lbs) |
| 42         | LHD45        | Light Heavy Duty (14K lbs < GVWR <= 19.5K lbs) |
| 46         | MHD          | Medium Heavy Duty (19.5K lbs < GVWR <=33K lbs) |
| 47         | HHD          | Heavy Heavy Duty (GVWR > 33K lbs) |
| 48         | Urban Bus    | Urban Bus (see CFR Sec. 86.091_2) |

<table>
<thead>
<tr>
<th>fuelTypeID</th>
<th>fuelTypeDesc</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Gasoline</td>
</tr>
<tr>
<td>2</td>
<td>Diesel Fuel</td>
</tr>
<tr>
<td>3</td>
<td>Compressed Natural Gas (CNG)</td>
</tr>
<tr>
<td>4</td>
<td>Liquefied Petroleum Gas (LPG)</td>
</tr>
<tr>
<td>5</td>
<td>Ethanol (E-85)</td>
</tr>
<tr>
<td>9</td>
<td>Electricity</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>activityTypeID</th>
<th>activityTypeDesc</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Distance traveled</td>
</tr>
<tr>
<td>2</td>
<td>Source Hours</td>
</tr>
<tr>
<td>3</td>
<td>Extended Idle Hours</td>
</tr>
<tr>
<td>4</td>
<td>Source Hours Operating</td>
</tr>
<tr>
<td>5</td>
<td>Source Hours Parked</td>
</tr>
<tr>
<td>6</td>
<td>Population</td>
</tr>
<tr>
<td>7</td>
<td>Starts</td>
</tr>
<tr>
<td>9</td>
<td>Average Horsepower</td>
</tr>
<tr>
<td>10</td>
<td>Fraction Retrofitted</td>
</tr>
<tr>
<td>11</td>
<td>Number Units Retrofitted</td>
</tr>
<tr>
<td>12</td>
<td>Load Factor</td>
</tr>
<tr>
<td>13</td>
<td>Hotelling Diesel Aux</td>
</tr>
<tr>
<td>14</td>
<td>Hotelling Battery or AC</td>
</tr>
<tr>
<td>15</td>
<td>Hotelling All Engines Off</td>
</tr>
<tr>
<td>ID</td>
<td>pollutantname</td>
</tr>
<tr>
<td>----</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>Total Gaseous Hydrocarbons</td>
</tr>
<tr>
<td>2</td>
<td>Carbon Monoxide (CO)</td>
</tr>
<tr>
<td>3</td>
<td>Oxides of Nitrogen (NOx)</td>
</tr>
<tr>
<td>5</td>
<td>Methane (CH4)</td>
</tr>
<tr>
<td>6</td>
<td>Nitrous Oxide (N2O)</td>
</tr>
<tr>
<td>20</td>
<td>Benzene</td>
</tr>
<tr>
<td>21</td>
<td>Ethanol</td>
</tr>
<tr>
<td>22</td>
<td>MTBE</td>
</tr>
<tr>
<td>23</td>
<td>Naphthalene particle</td>
</tr>
<tr>
<td>24</td>
<td>1,3-Butadiene</td>
</tr>
<tr>
<td>25</td>
<td>Formaldehyde</td>
</tr>
<tr>
<td>26</td>
<td>Acetaldehyde</td>
</tr>
<tr>
<td>27</td>
<td>Acrolein</td>
</tr>
<tr>
<td>30</td>
<td>Ammonia (NH3)</td>
</tr>
<tr>
<td>31</td>
<td>Sulfur Dioxide (SO2)</td>
</tr>
<tr>
<td>32</td>
<td>Nitrogen Oxide (NO)</td>
</tr>
<tr>
<td>33</td>
<td>Nitrogen Dioxide (NO2)</td>
</tr>
<tr>
<td>34</td>
<td>Nitrous Acid (HONO)</td>
</tr>
<tr>
<td>35</td>
<td>Nitrate (NO3)</td>
</tr>
<tr>
<td>36</td>
<td>Ammonium (NH4)</td>
</tr>
<tr>
<td>40</td>
<td>2,2,4-Trimethylpentane</td>
</tr>
<tr>
<td>41</td>
<td>Ethyl Benzene</td>
</tr>
<tr>
<td>42</td>
<td>Hexane</td>
</tr>
<tr>
<td>43</td>
<td>Propionaldehyde</td>
</tr>
<tr>
<td>44</td>
<td>Styrene</td>
</tr>
<tr>
<td>45</td>
<td>Toluene</td>
</tr>
<tr>
<td>46</td>
<td>Xylene</td>
</tr>
<tr>
<td>51</td>
<td>Chloride</td>
</tr>
<tr>
<td>52</td>
<td>Sodium</td>
</tr>
<tr>
<td>53</td>
<td>Potassium</td>
</tr>
<tr>
<td>54</td>
<td>Magnesium</td>
</tr>
<tr>
<td>55</td>
<td>Calcium</td>
</tr>
<tr>
<td>56</td>
<td>Titanium</td>
</tr>
<tr>
<td>57</td>
<td>Silicon</td>
</tr>
<tr>
<td>58</td>
<td>Aluminium</td>
</tr>
<tr>
<td>59</td>
<td>Iron</td>
</tr>
<tr>
<td>60</td>
<td>Mercury Elemental Gaseous</td>
</tr>
<tr>
<td>61</td>
<td>Mercury Divalent Gaseous</td>
</tr>
<tr>
<td>62</td>
<td>Mercury Particulate</td>
</tr>
<tr>
<td>63</td>
<td>Arsenic Compounds</td>
</tr>
<tr>
<td>65</td>
<td>Chromium</td>
</tr>
<tr>
<td>66</td>
<td>Manganese Compounds</td>
</tr>
<tr>
<td>67</td>
<td>Nickel Compounds</td>
</tr>
<tr>
<td>68</td>
<td>Dibenzo(a,h)anthracene particle</td>
</tr>
<tr>
<td>69</td>
<td>Fluoranthene particle</td>
</tr>
<tr>
<td>70</td>
<td>Acenaphthene particle</td>
</tr>
<tr>
<td>71</td>
<td>Acenaphthylene particle</td>
</tr>
<tr>
<td>72</td>
<td>Anthracene particle</td>
</tr>
<tr>
<td>73</td>
<td>Benz(a)anthracene particle</td>
</tr>
<tr>
<td>74</td>
<td>Benzo(a)pyrene particle</td>
</tr>
<tr>
<td>75</td>
<td>Benzo(b)fluoranthene particle</td>
</tr>
<tr>
<td>76</td>
<td>Benzo(g,h,i)pyrene particle</td>
</tr>
<tr>
<td>77</td>
<td>Benzo(k)fluoranthene particle</td>
</tr>
<tr>
<td>78</td>
<td>Chrysene particle</td>
</tr>
<tr>
<td>79</td>
<td>Non-Methane Hydrocarbons</td>
</tr>
<tr>
<td>80</td>
<td>Non-Methane Organic Gases</td>
</tr>
<tr>
<td>81</td>
<td>Fluorene particle</td>
</tr>
<tr>
<td>82</td>
<td>Indeno(1,2,3,c,d)pyrene particle</td>
</tr>
</tbody>
</table>
MOVES2014a Quick Start Guide

Introduction
The purpose of this guide is to provide experienced MOVES users with a brief narrative overview of the major functional changes included in MOVES2014a.

Can I still run MOVES2014 if I’ve downloaded MOVES2014a?
Yes, MOVES2014 will still continue to run even after the installation of MOVES2014a.

How do I convert MOVES2014 input databases into MOVES2014a format?
EPA has provided a database converter for both project and county scale databases. The converter can be accessed from the Tools menu of the GUI. It is entitled: “Convert MOVES2014 County or Project Input to MOVES2014a”. Note there have been changes to the default data in the fuels and I/M tables in MOVES2014a. After converting an input database from MOVES2014 to MOVES2014a, users should export the default MOVES2014a fuels and I/M tables and make any local adjustments to the MOVES2014a default tables rather than continuing to use MOVES2014 default fuel and I/M tables.

Can I use an existing MOVES2014 output database when running MOVES2014a?
No, the format of the MOVES2014a output data is different than the format of the MOVES2014 output database. The MOVES2014 output database will not properly accept data from MOVES2014a. When running MOVES2014a, the user must create a new output database.

What changes have been made to the MOVES GUI?

On Road Vehicle Equipment

MOVES2014a automatically deletes invalid source use type and fuel combinations (e.g. diesel motorcycles). Liquefied Petroleum Gas (LPG) is no longer a fuel option for onroad vehicles.

Pollutant and Processes for NONROAD

MOVES2014a includes changes to the Pollutant and Processes panel in Nonroad. It now includes an expanded list of pollutants. These include hydrocarbon speciation and a complete list of air toxics. The look and feel of this nonroad panel is now very similar to the corresponding on-road panel.

Aggregation Output Option for NONROAD

In the output emissions detail panel, users can now choose a full range of aggregation of output options. These include: model year, fuel type, fuel subtype, emission process, scc, sector, engine technology and hp class.

Fuel Subtype Output Option for NONROAD

In the output emissions detail panel, users now have the option to output by “Fuel Subtype” if a Nonroad selection has been made in the Scale panel. It also must be selected along with fuel type output option. Selecting this
option will not affect the total inventory, but will provide a breakdown of emissions by fuel sub type class. If chosen it will not provide a fuel subtype breakdown of the MOVES activity results (only emissions).

What changes have been made to MOVES inputs?
EPA has made several improvements and added flexibility to how users can provide local data to the model. The following are new or improved input options.

On-road Importer

MOVES2014a adds additional options for VMT input. VMT can be entered as either annual VMT or daily VMT. VMT can also be entered by either HPMS Class or by Source Type. As a result, there are now four options for entering VMT data in MOVES2014a (all available through the Vehicle Type VMT tab of the County Data Manager):

1. Annual VMT by HPMS Class
2. Daily VMT by HPMS Class
3. Annual VMT by Source Type
4. Daily VMT by Source Type

Nonroad Importer

MOVES2014a now offers the ability for the user to import a limited amount local data into a Nonroad runspec (MOVES2014 did not offer this capability). Specific importer tabs have been created that allow the user to import local fuel and meteorology data. These are accessed only from the “Nonroad Data Importer” found on the “Pre-Processing” menu bar.

Nonroad Fuel RegionID

The Fuel RegionID system for on-road was extended to Nonroad in MOVES2014a. The obvious impact of this change is that the nonroad fuel supply table (nrFuelSupply) now has a column for fuelregionID rather than countyID. Using the MOVES2014 to MOVES2014a converter will automatically add the appropriate fuel region ID to the nonroad fuel supply table.